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Legal Information

Intel Corporation (Intel) makes no warranty of any kind with regard to this material, including, but not limited to, the implied
warranties of merchantability and fitness for a particular purpose.

Intel assumes no responsibility for any errors that may appear in this document.
Intel makes no commitment to update nor to keep current the information contained in this document.
No part of this document may be copied or reproduced in any form or by any means without prior written consent of Intel.

An Intel product, when used in accordance with its associated documentation, is "Year 2000 Capable" when, upon
installation, it accurately stores, displays, processes, provides, and/or receives date data from, into, and between the
twentieth and twenty-first centuries, including leap year calculations, provided that all other technology used in combination
with said product properly exchanges date data with it.

Nothing in this document constitutes a guarantee, warranty, or license, express or implied.

Intel disclaims all liability for all such guaranties, warranties, and licenses, including but not limited to: fitness for particular
purpose; merchantability; not infringement of intellectual property or other rights of any third party or of Intel; indemnity; and
all others.

The reader is advised that third parties may have intellectual property rights that may be relevant to this document and the
technologies discussed herein, and is advised to seek the advice of competent legal counsel, without obligation to Intel.

The Intel Server Control product may contain design defects or errors known as errata that may cause the product to
deviate from published specifications. Currently characterized errata are available on request.

T Third-party brands and names are owned by their respective companies.

Copyright O 1999, 2000 Intel Corporation.
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Using Platform Instrumentation Control

What Is Platform Instrumentation Control?

Platform Instrumentation Control (PIC) uses the Desktop Management Interface (DMI) 2.0
framework to manage Windows NTT, Windows 2000, NetWare', Solaris, Linux, and UnixWaret
server hardware components. PIC provides real-time monitoring and alerting for server hardware
SeNnsors.

PIC has two main software components:

e The managed server: PIC Server Instrumentation (called Platform Instrumentation [PI]) is
installed on the NetWare, Windows NT, Windows 2000, Solaris, Linux, or UnixWare server
that is going to be managed by the PIC Console software.

«  The managing console: PIC Console software isinstalled on the user consol e that will manage
the server.

On aWindows NT or Windows 2000 network, it is possible to install both parts of the software on

the same server. It isalso possibletoinstall both the Server Instrumentation and the

Console software on multiple systems.
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Features

The following list summarizes the features of PIC:

Graphical user interface
Consolidated server health information
Interchassis management viathe Intelligent Chassis Management Bus (ICMB)

Enterprise console integration (PIC runs under HP Network Node Manager; LANDesk® Server
Manager; and CA-Unicenter’ TNG, as well as under the Intel Server Control Console)

Remote installation
RPC-based transport mechanisms
DMI 2.0 service providers

System administrators can use PIC to:

Remotely monitor server hardware sensors

Configure sensor thresholds

Update the server's LCD display (if available)

Configure, receive, and act upon alert eventsin the system event log (SEL)
Configure audio or visual notifications in response to an event

Configure options to shut down, reboot, or power-off the system automatically in response to
an event
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Tracking System Status
Using PIC, you are able to track system status and manage hardware conditions such as:

e Temperature

e Voltage

e Cooling fan status

» Chassisintrusion

« ECC memory

*  Processor status

e Power supply status

e PCI Hot Plug (PHP) slot status

Some of these conditions have a threshold or range of acceptable values. Default values are
configured during system manufacturing. These values, along with the current readings, error
status, and timer settings, can be configured and monitored through PIC. An event occurs when a

parameter crosses a defined threshold. At the time an event occurs, PIC initiates the action you
have configured.

For example, if the temperature reaches alevel that is outside of the user-defined threshold, an
event has occurred. Y ou can configure PIC to respond to this event in multiple ways, such as:

» Display amessage or sound an alert
»  Shut down the server
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* Record the event in asystem log
Y ou can aso use PIC to view:

»  System hardware inventory

e BIOS and system slot information

e Onboard Adaptec SCSI controller status

*  Onboard LS| (Symbios) SCSI controller status
e Onboard Intel® LAN adapter status
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Managing Third-Party Components, DMI, and MIF Files

PIC uses the Desktop Management Interface (DMI) to monitor components, such as hardware
sensors, inventory information, and third-party instrumentation on server systems. PIC monitors
the motherboard, chassis, onboard Adaptec’ and LSIT (Symbios) SCSI controllers, and onboard
Intel LAN adapters.

To provide these capabilities, each DMI-enabled component must provide a Management
Information Format (MIF) file, which describes the manageabl e attributes of that component. For
example, the current reading of atemperature sensor is an attribute that could be listed in aMIF
file.

The PIC Console GUI running on alocal management console (Windows NT or Windows' 98)
can manage components on a remote managed server (Windows NT, NetWare, or UnixWare).
PIC aso includes a trandlator to alow management of the DM I-enabled component
instrumentation from a remote SNM P application.

For more information on DM, see the Desktop Management Task Force (http://www.dmtf.org) on
the World Wide Web.

Getting the Latest Information and Support

PIC is frequently enhanced and updated to support new features and platforms, and to address
issues discovered within the application. For updated information on such changes, see the PIC
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release note files (ENUREADME.TXT and ENUERRATA.TXT). If you have questions or need
help using PIC, contact your service representative.
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Glossary

The following terms and abbreviations are used in this document:

Term Description

DIMM Dual In-line Memory Module

DMI Desktop Management Interface

DPC Direct Platform Control

ISC Intel Server Control

LDSM LANDesk Server Manager

MIF Management Information File, used by DMI for describing component
instrumentation

MMC Microsoft Management Console

NMI Non-Maskable Interrupt

ONC Open Network Computing

PHP PCI Hot Plug

PIC Platform Instrumentation Control

RAID Redundant Array of Inexpensive Disks

RPC Remote Procedure Call

SBE Single-Bit Error
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SEL System Event Log

SMI System Management Interrupt

SNMP Simple Network Management Protocol, a standard network protocol for
management information

SSU System Setup Utility

10
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System Requirements

PIC has two main software components:

* PIC Server Instrumentation software is installed on the NetWare, Windows NT, Windows
2000, Solaris, Linux, or UnixWare server to be managed by the PIC Console software.

* PIC Console software isinstalled on a Windows NT/Windows 2000 server or workstation, or
on aWindows 98 workstation, that will manage the server.

Both the managing console(s) and the managed server(s) must meet the minimum system

requirements listed below.

Managed Server Requirements

PIC supports several Intel motherboards. For a complete list of supported server motherboards and
qualified BIOS revision levels, see the PIC release note files (ENUREADME. TXT and
ENUERRATA.TXT). Thefollowing are requirements for the supported operating systems.

11
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NetWare Requirements
If you intend to manage a NetWare server, you must have an account with supervisor- or
administrator-equivalent rights available to you. The server must also meet the following
minimum requirements:

* NetWare 4.2 or 5.0 symmetric multiprocessing (SMP)

e One of the Intel® motherboards specified in the rel ease notes

» Atleast 24 MB of RAM

e Atleast 60 MB of available disk space

*  NetWare SNMP NLM installed (required only for connectivity to an SNM P management
console)

* ONCRPC

12
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Windows NT Requirements

If you intend to manage a Windows NT server, you must have an account with administrative
rights available to you. The server must also meet the following minimum requirements:

e Windows NT Server 4.0 (SP5), or Enterprise Edition

e One of the Intel motherboards as specified in the rel ease notes

« 32MBof RAM

e 60 MB of available disk space

e Windows NT SNMP or SNMP serviceinstalled (required only for connectivity to an SNMP
management console)

e The RPC service must be set to interact with the desktop

Windows 2000 Requirements

If you intend to manage a Windows 2000 server, you must have an account with administrative
rights available to you. The server must also meet the following minimum requirements:

e Windows 2000

e One of the Intel motherboards as specified in the rel ease notes
* 64 MBof RAM

e 60 MB of available disk space

13
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Sun Solaris Requirements

If you intend to manage a Solaris file server, you must have an account with root privileges
available to you. The server must also meet the following minimum requirements:

e Solaris7.0

e One of the Intel motherboards supported under Solaris as specified in the release notes
« 32MBof RAM

e 60 MB of available disk space

Linux Requirements
If you intend to manage a Linux file server, it must meet the following minimum reguirements:

e RedHatLinux 6.1

e One of the Intel motherboards supported under Lunix as specified in the release notes
« 32MBof RAM

e 60 MB of available disk space

SCOT UnixWare Requirements

If you intend to manage a UnixWare file server, you must have an account with root privileges
available to you. The server must also meet the following minimum requirements:

e SCO UnixWare 7.01

14
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»  Oneof the Intel motherboards supported under UNIX T as specified in the release notes
+ 32MBof RAM

e 60 MB of available disk space

e UNIX SNMP and ONC RPC installed

Additional Requirements for DMI-SNMP Translation

SNMP support must be installed if you want to integrate PIC with an SNM P-based management
framework. For SNMP installation information, see your Windows NT, NetWare, or UnixWare

documentation.
On the managed server, you should consider the following issues when configuring SNMP:

e Community string names for SNMP Get and Set operations and for sending traps
* Thedestination address for the management console receiving the traps
On the management console, you should consider the following issues when configuring SNMP:

e Compiling the MIBs into the SNM P management consoles
» Integration of PIC trapsinto SNM P management consoles

15
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Console Requirements

Console System requirements may change when snapping into one of the supported management
applications. Please refer to their installation requirements for additional information.

The PIC Console software integrates into HP Network Node Manager, Intel LANDesk Server
Manager, or CA Unicenter-TNG consoles. See PIC release notes for supported versions of these
software packages. PIC aso runs under the Intel Server Control Console.

Windows 98

e Intel® Pentium® microprocessor or higher
e Atleast 32 MB of RAM

e Atleast 10 MB of available disk space

e A remoteregistry service

Windows NT

e Windows NT Server or Workstation 4.0 (SP4)

e Intel Pentium microprocessor or higher

» Atleast 64 MB of RAM

e Atleast 10 MB of available disk space

* The RPC service must be set to interact with the desktop

16
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Windows 2000

e Windows 2000

e Intel Pentium microprocessor or higher

» Atleast 64 MB of RAM

e Atleast 10 MB of available disk space

* The RPC service must be set to interact with the desktop

17
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Preparing Managed Servers

Platform Instrumentation Control uses the event-logging feature of the BIOS for system
management status and information. To enable this feature for each server to be managed with
PIC, you must boot the server(s) using the System Configuration Utility (SCU) or System Setup
Utility (SSU) and set the appropriate options under System Management Options. For
motherboard-specific settings and values, see the PIC release note files (ENUREADME.TXT and
ENUERRATA.TXT).

[] NOTE
It is possible to configure temperature and voltage threshol ds on the server
system using the SCU or SSU. However, the thresholds set with the SCU or
SSU arein effect only for a short time during the system boot process. PIC
overwrites these thresholds when the OS loads. We therefore recommend
that all threshold changes be made using PIC.

18
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Compatibility and Upgrade Issues

If you have earlier versions of LSC or LDSM on your network, be aware of the following:

e Versionsof LDSM with LSC prior to and including 2.8 are not supported under PIC.

»  The PIC-managed server installation will not upgrade the DMI service provider or any DMI
database that is already installed on the managed server. However, if a service provider is not
found, PIC installsa DMI 2.0 service provider.

e ThePIC server ingtallation process installs the remote procedure call (RPC) transports (DCE
and ONC) if they are not available on the managed server.

e ThePIC GUI uses RPC transports (DCE and ONC) and DMI 2.0 commands to communicate
with DMI 2.0-based managed servers.

e |SC 2.x isshipped with the DMI 2.0s Service Provider for Windows NT and Windows 2000.
The 2.0s version is an extension of the Service Provider that supports security. PIC does not
use those features, but they are available under Windows NT for possible use by other DMI
2.0s-compliant software.

Customizing NetWare Servers After Setup

Whileinstalling PIC, the configuration and Setup program installs Adaptec and LSl (Symbios)
SCSl, and Intel LAN Adapter instrumentation on the NetWare server but does not enable the
instrumentation support.

19
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To enable support for any or all instrumentation, you must edit the PIC_ON.NCF filein the
SYS:SYSTEM directory.

To enable the Adaptec SCSI instrumentation, remove the word REM from these linesin the
PIC_ON.NCFfile:
REM | oad i ongr

REM | oad dmi shim
To enable the Intel LAN Adapter instrumentation, remove the word REM from these linesin the
PIC_ON.NCFfile:

REM | oad e100bdmi . nl m/auto
To enable the LSl (Symbios) SCSI instrumentation, remove the word REM from these linesin the
PIC_ON.NCFfile:

REM | oad sinti nw. nl m

20
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Launching Platform Instrumentation Control

PIC can be launched from and can manage servers from one of these management environments:

e LANDesk Server Manager (LDSM)
e HP Network Node Manager

e CA-Unicenter TNG

* Intel Server Control Console

Once the PIC GUI application is launched from a management consol e, the management console
application can terminate, and PIC will continue to operate normally.

LANDesk® Server Manager

The LDSM console dynamically builds its feature set when communication is established with a
managed server. |If the managed server is running the Platform Instrumentation software, the
LDSM console adds an option for “ Platform Instrumentation Control” as alaunch point in the
Tools branch of the LDSM navigation tree. Select this option to launch the PIC applet.

21
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HP Network Node Manager

The HP Network Node Manager Consol e autodetects servers running the PIC Component
Instrumentation software. The Console updates the server bitmap with an PIC server icon for
those servers.

To launch the PIC applet, select an PIC-enabled server on the HP Console network map, and then
select the "Platform Instrumentation Control Applet" option from the Tools Menu. Alternatively,
you can launch the PIC applet by selecting an PIC-enabled server on the HP console network map,
clicking the right mouse button, and then selecting the "Platform Instrumentation Control™ option
from the popup menu.

CA-Unicenter TNG

The CA-Unicenter TNG Consol e autodetects servers running the PIC Component Instrumentation
software if you have enabled the PIC to CA discovery service. To enable discovery, you must start
the "Intel Tng-PIC AutoDiscovery” service. You can start this service from either the TNG
Unicenter "Auto Discovery" dialog or from the Windows NT "Services' applet.

The"Intel Tng-PIC AutoDiscovery" service creates a new "Platform Instrumentation Control"
TNG object for each server having the PIC Component Instrumentation software. That TNG
object displays on the map as a child of the "PIC World View" and as a child of the PIC-enabled
server. You can view al PIC-enabled servers under the "PIC World View."

22
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To launch the PIC applet, right-click on a"Platform Instrumentation Control™ icon, and select the
“Launch PIC" option from the popup menu.

Intel Server Control Console

The Intel Server Control Consoleis alightweight management console that provides basic server
management without having to use an enterprise management console (such as HP OpenView) or a
workgroup management console (such as LANDesk Server Manager).

To launch PIC from within the Intel Server Control Console, click the PIC icon in the Tool Pane.

23
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Using the Platform Instrumentation Control
Console

When you start PIC, the main window displays atree view. Y ou can expand the view to show the
sensor types supported on the managed server and further expand it to display detailed sensor
information.

A presentation area on the main PIC window displays current readings, threshold configurations,
inventory, and other related information for selections made in the tree view. The main window
aso displaysthe server’s LCD (if available) and a picture of the PIC bitmap.

Most of the PIC sensors have associated thresholds that trigger alert actions when the thresholds
are crossed. You can:

»  Specify which alert actions you want to occur.

e Maodify the default thresholds.

« Configure the default actions and notifications for each threshold.
When a parameter crosses a threshold, you can have PIC:

»  Beep the speaker on the managed server.
e Display an alert on the managed server.
* Logtheevent to disk on the managed server.

24
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e Broadcast a message.
*  Write amessage to the LCD on the managed server.
e Page an administrator.

e Use one of the shutdown/power control options to shutdown the OS, do a hardware reset, or
power-off the server.

« Runany LANDesk Alert Management System (AMS?) alert action if LANDesk Server
Manager isinstalled on the managed server and managing console. For more information on
AMS’, seethe Intel LANDesk Server Manager Administrator’s Guide.

25
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The PIC Console Main Screen

PIC uses a Windows Explorer-like model, with a navigation pane (tree view) and a presentation
pane (list view). When you select a sensor from the tree, the presentation pane shows a set of
tabbed pages with sensor-specific information.

26
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Main Menu bar

Icon Toolbar

Navigation Pane)

LCD Display Pane

Status Bar

Presentation Pane

The main screen of the PIC application is continually updated to show current sensor status.
Specific PIC sensor dialogs (such as temperature and voltage sensors) show the current sensor
reading when displayed but are not dynamically updated.

moow>»

n
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Main Menu Bar

The Main Menu Bar includes the following options:

Item
File Menu
View Menu

Configure Menu

Options
Exit: Exits the application

Toolbar: Toggles the toolbar on or off.

Status Bar: Toggles the status bar on or off.

PIC Bitmap: Toggles the PIC bitmap pane on and off.
Large Icons: Displays list using large icons.

Small Icons: Displays list using small icons.

List: Displays items in list format.

Details: Displays items in detail format.

Arrange Icons: Arranges icons by name or status.
Refresh: Triggers an immediate screen and data refresh.
Options: Displays the view options dialog so you can configure viewing preferences,
such as temperature format and display refresh rate.

Enable Front Panel Power & Reset: Toggles the front panel power and reset option.
Enable Watchdog Timer: Toggles the watchdog timer option. When this option is
enabled, you can set the timer value.

Watchdog Timer Value: When the watchdog timer option is enabled, the timeout
dialog appears so you can set the timeout value. When the timer is disabled, the
dialog does not appear.

Restore Factory Defaults: Restores factory default values for threshold sensors,
console refresh interval, and the Watchdog Timer.

Paging Configuration - This command takes you to the paging Configuration dialog

29
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box.
ICMB Menu View Managing Server: Enables the default local managing server view.
View Managed Server(s): Accesses the ICMB-managed server view(s).
Reclaim Inactive Resources: Reclaims inactive ICMB resources on the managing
server.

Help Menu Help Topics: Accesses PIC help topics.
About PIC: Displays PIC version information.

30
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Icon Toolbar

Table 3 liststhe itemsin the Icon Toolbar. The order of the itemsin the table, top to bottom,
reflects the order of the icons on the main screen, left to right. To hide the icon toolbar, click the
right mouse button over the toolbar, and then click on the “Hide” popup menu that appears.

Table 3. Icon Toolbar Items

Icon Name Options

Up One Level Takes you up one level in the tree (navigation) view
m PIC Bitmap Toggles the PIC bitmap pane on or off

By Large Icons Displays list using large icons

Small Icons Displays list using small icons

e List Displays items in list format

EE Details Displays items in detail format

31
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Navigation Pane

The Navigation Pane shows a tree view of server components that can be monitored. Many
branches of the tree represent group components that have subbranches (nodes). These group
items are identified by the tree expansion icons (“+” or “-") appearing to the left of the component
name. These branches can be expanded to list nodes (detail sensor list) or collapsed to hide nodes.

Server Bitmap

The Server Bitmap shows a picture of the server splash screen. To hide the picture, click the right
mouse button over the picture, and then click on the “Hide” popup menu that appears or click on
the PIC Bitmap icon on the tool bar.

LCD Display

The LCD Display Pane shows the actual server LCD contents and a button to set the LCD contents
on the server. If the server hardware does not support LCD, the pane does not display.

32
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Status Bar

The Status Bar displays status messages. To hide the status bar, click the right mouse button over
the status bar, and then click on the “Hide” popup menu that appears.

Presentation Pane

When you select a branch (group component) in the navigation pane, the presentation pane
displays a set of icons (list view) representing each group node (detail sensor list). The detail view
provides more information on each node item. Y ou can arrange these list view items by name
(sorted alphabetically) or by status (sorted by current status: critical, noncritical, and OK). To
change the presentation pane, click the right mouse button over the pane, and then select from the
popup menu that appears. This popup menu has two items:

* View— Changes between large icons, small icons, list, or detail view

e Arrangelcons— Arrangesthelist view icons by name or status

When you select a node in the navigation pane, the presentation pane displays a set of tab pages
representing the detail sensor information. Depending on the node selected in the navigation pane,
one of the following four pages s displayed:

e Sensor Settings— Displays the sensor’s current status and current value, threshold values and
error counts.

33
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Use this screen to configure new threshold values (such as Upper Critical Threshold, Upper
Noncritical Threshold).

The sensor statusis also represented as a colored “Health” icon: Red iscritical, Yellow is
noncritical, Green is OK, and Blue is an unsupported sensor.

« Alert Actions— Displays the currently configured alert actions for each threshold type (such
as Voltage-Status Changed to Upper Critical, V oltage-Status Changed to Lower Critical).

Use this screen to change the aert actions for each supported threshold. The factory default
alert actions are Log the Event to Disk and Write a Message to the LCD. The AMS Alert
configuration option is available only when PIC isintegrated with LDSM; when thisfeature is
not available, the AMS Alert option is disabled.

e Sensor Information— Displaysindividual sensor information (such as Sensor Tolerance,
Maximum Reading, Minimum Reading).

* Inventory Information— Displays inventory information for the sensor (such as Description,
Manufacturer). The information varies based on the sensor type.




Intel Platform Instrumentation Control Version 2.2

Sensor Dialogs

Alert Actions

All of the sensor dialogs have an Alert Actions tabs with them. Usethe Alert Actions tab to
specify the actions to be taken in the event of an aert on the associated sensor.

The factory default alert actions are to log the event to disk and to write a message to the server’s
front-panel LCD.

The AMS alert configuration is only available when PIC isintegrated with LANDesk" Server
Manager (LDSM). When thisfeature is not available, the corresponding GUI controls will be
disabled.

35
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Sensor Information

Each sensor has a sensor information tab that displays individual sensor information, such as
specifications and reading extremes.

Sensar Seftings I Alerd Actions 5 | Inventary Information I

MName “alue |
Sensor Accuracy

Sensor Tolerance

Sensor Fesolution

MNaminal Reading

Maximum Reading

inimum Reacding

Lowest Mormal Reading

Highest Mormal Reading

Help |
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Inventory

Version 2.2

Each sensor as an inventory information tab that shows information about the characteristics of the

Sensor.

Sensor Seflings I Alert Actions I Sensor Information

Marne | Yalue

Description
Manufacturer
Model

Fart Mumber
Cornponent Nurnber
Serial Number
Fewvision Lewvel

Help |
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Health

Information about all unhealthy sensorsis copied under the Health branch. Select the Health
branch of the server tree in the navigation pane to get a quick and simple view of the current server
health. If, for example, a 12V voltage sensor indicates that the current status is not OK, then data
about that 12V sensor is added to the Health branch of the tree. Y ou can select the 12V entry in
either the Health or Voltage branch of the tree to display information about the sensor.

All sensorsin either acritical or noncritical condition will appear in the Health branch of the tree
in addition to their normal location in other areas of the navigation tree. In thisway, you can get a
quick summary of problem areas on your server and begin corrective actions.

39
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Colored iconsin the Health branch of the server tree indicate individual sensor status and overall
server status:

e Green: heathy server

e Yedlow: noncritical conditions

e Red: critical failures

e BlueQuestion Mark: unsupported sensors

The color of the overall server health icon will display the state of the most severe sensor status. If
any sensor isin acritical condition (regardless of other sensors being in a noncritical condition),
the server health status will be shown as critical (red). If there are only noncritical sensors, the
server health status will be shown as noncritical (yellow). If al sensors report normal conditions,
the server health status will be shown as OK (green).
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Chassis

PIC monitors chassis door open/closed switches for managed servers that support thisfeature. The
number of sensors monitored depends on the server chassis.

The chassisintrusion sensor screen displays the current security status. Not all servers support this
component.

sSensor Seflings |AlenAdiDns| Sensurlnfurmatinnl Inventm‘ylnfurmationl

OCurrent Status (0]4

Error Count
’7 Critical : 1]

Helg

Figure 5. Chassis

When a chassis door that includes an open/close switch is opened, the vulnerable state is indicated
asacritical condition in the health branch of the PIC Console, and the requested event actions are

carried out. When al chassis doors that include an open/close switch are closed, PIC indicates the
chassisis secure and carries out the requested event actions.
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For systems that do not support chassis open/closed switches, this portion of the PIC Console will
either not display or the chassis status will be reported as “ Unknown.”
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Fan

The fan sensor screen displays actual fan RPM for systems that support this feature. The threshold
appears in terms of the RPM value. If the current fan RPM value falls below the specified
threshold value, then the sensor status changes and an event generates. For the systems that do not
support fan RPM threshold, the threshold setting is 0 and read-only. If the fan stops, then the
sensor status changes and an event generates.

Sensor Seftings |AIertAct\0ns| Sensarlnformationl Inventorylnformationl
O Current Status oK
Current Value : 1655 RPM
~ Threshold
W] eyl T =t L] I ill R
Uppen Nen-Critiesl Ttresheld I i’ R
Lower Man-Critical Threshald |1EDD i’ FPk
Lowver Critical Threshold IQUU i’ FFhd
—Errar Count:
Mon-Critical : 1]
Critical : 1]
Apply | Help
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PIC monitors two types of fans:

* Rotation-sensing fans—PIC can detect whether afan has stopped but is not able to indicate
which fan hasfailed. These fans, together, are treated as asingle fan unit. Therefore, event
actions must be configured for all fans together, rather than separately.

* RPM-sensing fans—PIC can detect whether an individual fan has either slowed or stopped and
will display the actual fan RPM value for systems that support this feature. Each RPM-sensing
fan isindependently configurable with its own threshold and event actions.

If arotation-sensing fan fails or an RPM-sensing fan crosses a threshold, the PIC Console displays

the event as acritical condition viathe health branch of the software, and the requested event

actions are carried out.

For systems that do not support afan RPM threshold, the threshold setting displaysa“0” and is
read-only in the PIC Console display.
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ICMB

The ICMB diaog allows you to configure options for the Intelligent Chassis Management Bus
(ICMB).

The ICMB feature allows multiple remote devices to be interconnected and management
information shared among them. For example, your managed server could be configured to be an
ICMB primary server and report management information on other ICMB devices connected to it.
Using ICMB, PIC can manage the power state of remote ICMB devices and view FRU information
about those devices. The amount of FRU information avail able depends on the type of ICMB
device you are trying to manage.
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—#IMB Manage Point Configuration

¥ Enable as tManagement Foint

¥ Enabla Full Sensor view

Discovery Period : |2 ﬂ second(s)

HIMB Chassis Specific Configuration

IEnerna\ Chassis B j

W Enahle Full Sensor Wiew
W hanage Chassis

Ewvent Polling Period 2 il second(s)

—#IMB Local Server Configuration

¥ Accept Femote Commands

Apply I Help |

Through the PIC Console, you can switch your view of the primary managed server to one of the
ICM B-managed devices and view the available information on that device without losing the
connection with the primary server. Y ou can change your view back to the primary server or any
other ICMB-managed device at any time. Through the PIC Console, you can configure the ICMB
management features of the primary managed server and the remote |CMB-managed devices.

46




Intel Platform Instrumentation Control Version 2.2

e Local ICMB Server Configuration— With thisoption it is possible to enable the local server
as a management point, enable the full sensor view of remote devices, and change the
discovery period for remote devices.

*  Remote | CMB Chassis Configuration— With this option it is possible to configure each
remote device discovered viaICMB. Y ou can decide whether to manage the remote device,
enable full sensor view for the remote device, and set the event polling rate for the remote
device.

Y ou can reclaim inactive ICMB system resources on the primary server. Doing so frees the

memory taken up by the SDR and FRU information on the primary server for any remote device
that is no longer visible on the network (vialCMB).
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Memory Array

The memory array sensor screen displays information and status about each memory array.
Sensor-specific information is displayed in the Sensor Information tabbed page. Not al servers
support this component.
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Memory Device
The memory device sensor screen displays information and status about each memory device.
Sensor-specific information is displayed in the Sensor Information tabbed page. Not all servers
support this component.

Sensor Setings |AIer1A|::tiDns| Sensorlnfurmatiunl Inventurylnfurmatiunl

OCurrent Status CK.
Error Count:
Man-Critical : 0
Critical : 0

Help

PCI HotPlug Device

The PCI HotPlug Device sensor screen displays information about each PCI Hot Plug device
installed in aPHP dot. If the server hardware does not support PCI HotPlug it will not appear in
the navigation pane and the screen will not be available.
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Power Supply

The power supply sensor screen displays information and status about each power supply. The
information displayed includes power supply type, maximum current output, and etc. Sensor-
specific information is displayed in the Sensor Information tabbed page. Not all servers support
this function.

Sensor Setings |AIer1A|::tiDns| Sensorlnfurmatiunl Inventurylnfurmatiunl

OCurrent Status CK.
Error Count:
Man-Critical : 0
Critical : 0

Help
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Power Unit

For systems that support it, PIC monitors the status of the power suppliesin the managed server.
Each power supply isindependently configurable for event actions upon failure. The power unit
sensor screen displays information and status about each power unit. Not all servers support this

component.

Sensor Setings |AIer1A|::tiDns| Sensorlnfurmatiunl Inventurylnfurmatiunl

OCurrent Status CK.
Error Count:
Man-Critical : 0
Critical : 0

Help

If a power supply reports a predictive failure condition, then PIC reports the status as a non-critical
condition in the health branch of the PIC Console software, and the requested event actions are

carried out.
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If apower supply fails, the failure is reported as a critical condition in the health branch of the PIC
Console software, and the requested event actions are carried out. PIC also reports the system
power as nonredundant and as a noncritical condition in the health branch of the PIC Console
software, and the requested event actions are carried out.

For systems that do not support power supply sensors, this portion of the PIC Console software
will not display.

For those systems that support it, PIC monitors the managed server’s system power redundancy
status.

If apower supply fails or if the surplus power on the systemis less than the amount provided by
one power supply, PIC reports that the system power is nonredundant. This condition is indicated
with anoncritical statusin the health branch of the PIC Console software and the requested event
actions are carried out.

Processor

The processor sensor screen displays information and status about each processor. From this
screen, you can find out the type and speed of the processor. Sensor-specific information is
displayed in the Sensor Information tabbed page. Not all servers support this function.
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Sensor Settings | Alert Actions | Sensar Infarmation | Inventary Infarmation

OCurrent Status CK.
Error Count:
Man-Critical : 0
Critical : 0

Help

For motherboards that support it, PIC monitors processor failures during runtime and system boot
on the managed server. If asupported motherboard includes multiple processors, each processor
can be configured and monitored separately through PIC. If a processor failure is detected, the
failureisreported as a critical condition in the health branch of the PIC Console software, and the
requested event actions are carried out.

If processor sensors are not available on the motherboard, this portion of the PIC Console does not
display.
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System Slots

ISC gathers sensor information and slot status on all slots in your managed server. The dots are
categorized into two groups:

e PCI Hot Plug (PHP) slats (if the server hardware supports PCl HotPlug)
e All other non-PHP system dlots.

Slot names containing “PCl 64bit” identify PHP slots. For PHP dots, there are three pages
available in the presentation pane: Sensor Information page, Sensor Status page, and Alert Action

page.
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For non-PHP slots, only the Sensor Information pages displays.
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System Information

PIC gathersinformation on field replaceable unit (FRU) componentsinstalled in your managed
server. Thisinformation includes a component description, manufacturer, model, part number,
component number, serial number, and revision level. PIC also gathers information on other
system resources including Operating System, BIOS, and the System Event Log.

The inventory screen displays alist of components within the system. The inventory list shows the
description, manufacturer, model number, part number, serial number, and revision level of
baseboard components. The inventory list will include information on the baseboard, processor
board, chassis, power share board, hot-swap backplane, and memory devices.
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Irevertory Information

Name

Walue

Description
Manufacturer
Model

Part Mumber
Component Number
Serial Mumber
Fevision Level

Help

Version 2.2

If your server does not support one or more of these features, these portions of the PIC Console

will not display.
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Temperature

The temperature dialog contains all temperature sensors. Y ou can see individual sensor
information in the presentation pane by selecting the corresponding sensor node from the
navigation tree. Y ou can monitor current temperature readings, current status, sensor error counts,
and set sensor thresholds. Depending on the individual temperature sensor and the server
platform, some thresholds are unsupported and they appear disabled, grayed out, in the control.
The statusindicator in the upper left-hand corner shows the current status: ared stop sign means
“Critical,” ayellow caution sign means “Non-Critical,” and a green traffic light means “OK.”
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This table displays the information available for the temperature sensors.

Item Description

Maximum Reading The highest reading supported on this sensor.

Minimum Reading The lowest reading supported on this sensor.

Sensor Accuracy The sensor’s accuracy in +/- hundredths of a percent.

Sensor Tolerance (plus) The amount of variation over the actual value that can be reported.

Sensor Tolerance (minus) | The amount of variation under the actual value that can be reported.

Sensor Resolution The smallest unit of measurement reported by the sensor.

Nominal Reading The expected normal reading for this sensor.

Lowest Normal Reading The lowest normal reading of this sensor. Readings below this value indicate

an abnormal condition.

Highest Normal Reading The highest normal reading of this sensor. Readings above this value
indicate an abnormal condition.

Third-Party

Y ou can configure event actions for DMI indications generated by third-party Server
Instrumentation installed with PIC. Y ou can also monitor third-party instrumentation viathe DMI
Explorer Interface. PIC supports event configuration for Adaptec SCSI, LSI (Symbios) SCSI, and
Intel LAN Adapter Server Instrumentation.
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Voltage

In a managed server, PIC monitors many types of voltage sensors; the number and type depend on
the server hardware configuration. Each monitored voltage sensor has independently configurable
thresholds and event actions. Example voltage sensors are:

e 12V,5V, 35V, 33V, -5V, -12V
¢ Processors 1.5V and 2.5V
e SCS| A Termination 1, 2, and 3

The voltage dialog contains all voltage sensors. Y ou can see individual sensor information in the
presentation pane by selecting the corresponding sensor node from the navigation tree. With this
control, you can monitor current readings, current status, sensor error counts, and set sensor
thresholds. Depending on the individual voltage sensor and the server platform, some thresholds
are unsupported and they appear disabled (grayed out) in the control. Theindicator in the left-
hand corner shows the current status: ared stop sign means “ Critical,” ayellow caution sign means
“Non-Critical,” and a green traffic light means “ OK.”
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This table displays the information available for the voltage sensors.

Item

Maximum Reading
Minimum Reading
Sensor Accuracy

Sensor Tolerance (plus)
Sensor Tolerance (minus)
Sensor Resolution
Nominal Reading

Lowest Normal Reading

Highest Normal Reading

Description

The highest reading supported on this sensor.

The lowest reading supported on this sensor.

The sensor’s accuracy in +/- hundredths of a percent.

The amount of variation over the actual value that can be reported.
The amount of variation under the actual value that can be reported.
The smallest unit of measurement reported by the sensor.

The expected normal reading for this sensor.

The lowest normal reading of this sensor. Readings below this value indicate
an abnormal condition.

The highest normal reading of this sensor. Readings above this value
indicate an abnormal condition.
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Managing Servers with PIC

Viewing / Configuring Sensor Information

To view or configure a sensor (such as voltage, temperature), do the following steps:

1.

2.
3.

4.

On the PIC main window, click beside a sensor name in the navigation pane to see the list of
available sensors.

Select an entry from the list.

Switch between the available tab pages (Sensor Settings, Alert Actions, Sensor Information
or Inventory Information) to view or update the information.

Click <Apply> for any changes made to the sensor configuration.

At any time you can change views to another sensor by selecting another component in the
navigation pane.

If you try to change your view and you have not saved any configuration changes using the Apply
button in the presentation pane, PIC prompts you to save or discard the changes before switching
to anew view.
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Viewing System Information

To view system information (such as FRU, Operating System, BIOS, SEL) on the managed server
(or managed ICMB device), do the following steps:

1. Onthe PIC main window, click beside the System Information name in the PIC navigation
pane to see the list of options.

2. Select an entry fromthelist.

3. View theinformation in the corresponding tab page in the presentation pane.

At any time you can change views to another sensor by selecting another component in the

navigation pane.

On components that support FRU data, this inventory information is also displayed on the
Inventory Information tab page associated with that component.

System Event Log

The PIC Console software displays the System Event Log (SEL) maintained by the managed
server’s platform hardware. The SEL isa collection of log entries stored in nonvolatile flash
memory. The entries are reported by the BIOS SMI handler when an event condition occurs at the
server.

The Platform Instrumentation automatically extracts event information from the SEL and triggers
any user-configured actions associated with that event. The Platform Instrumentation clears the
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SEL when it is near an out-of-space condition. The PIC Console software also displays the SEL
logging status (whether the SEL is Active or Inactive).
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Configuring Thresholds
There are two basic types of threshold:
* Range-based thresholds for which avariety of values can be set. Example uses: for

temperatures, voltages, and RPM-sensing fans.

» State-based thresholds that have fixed values like OK or Critical. Example uses: for rotation-
sensing fan, chassis door, and memory array.

To Configure a Range-Based Threshold

Most voltage and temperature sensors and RPM-sensing fans have either one, two, or four
configurable thresholds, depending on the motherboard in your server. Example thresholds are:
e Upper Ciritical

e Upper Noncritical

* Lower Noncritical

* Lower Critical

Some special sensors do not have configurable thresholds and are displayed for monitoring
purposes only.

Y ou can customize the threshold value to suit your working environment.

Y ou can specify what action should occur when the sensor detects that one of the threshold values
has been crossed (i.e., the sensor state changes). Example state change conditions:
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Status Changed to OK

Status Changed to Upper Critical

Status Changed from OK to Upper Noncritical
Status Changed from Critical to Upper Noncritical

These thresholds and sensor state changes let you configure progressive responsesin PIC to
increasingly serious hardware conditions. For example, noncritical thresholds might be configured
to emit a beep from the speaker and send a broadcast message, while critical thresholds might
require more serious actions, like a server shutdown.

To configure a range-based threshold:

1

akrowbd

o

On the PIC main window, click beside the sensor name in the navigation pane to see the list of
available sensors.

Select an entry from the list.

Change the threshold values as needed on the Sensor Settings tab page.

Click <Apply> for any changes made to the threshold value configurations.

If you want to change the event actions associated with threshold state change conditions,
make the changes on the Alert Actions tab page.

Click <Apply> for any changes made to the alert action configuration.

[] NOTE

After applying new threshold values that may cause an event indication, the
sensor status icon displayed on the Sensor Settings tab page may not change.
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The consol e refreshes the display before the new threshold value takes effect
on the server, making it appear as though the sensor icon does not accurately
reflect the current state of the sensor. Use the menu option, View->Refresh,
or the F5 keyboard shortcut, to update the Sensor Settings tab page.

To Configure a State-Based Threshold

The state-based thresholds for processor, power supply, rotation-sensing fans, chassis door, and
memory arrays have afixed set of values, not arange. Example state change conditions:

e Single Bit Memory Error
e Processor Thermal Trip
e Power Supply Failed

[1 NOTE
For systems that support rotation-sensing fans, the fan RPM threshold setting
displaysa“0” and isread-only in the PIC Console software.

PIC generates an event whenever the state of these items changes. Y ou can specify which actions
should occur in response to changes. To configure a state-based threshold:

1. Onthe PIC main window, click beside a sensor name in the navigation pane to see alist of
available sensors.
2. Select an entry fromthelist.
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3. Select the Alert Actionstab. Change the event actions associated with a state change
condition.
4. Click <Apply> to save your changes.

Cautions in Setting Thresholds

Threshold Values Rounded Off

When you are setting threshol ds, the values you enter might not be the exact values set by the
software. This behavior is caused by hardware rounding. Redisplay the Sensor Settings tab page
to find the actual value set by the software.

Avoiding a Power On/Off Loop

Improperly setting event actions can cause the server to enter a state that prevents the server from
booting correctly. This can occur in the following scenario:

1. Anevent occurs. Example: a high-temperature threshold is exceeded.

2. Whilethe condition causing the event still exists, you set a Shutdown/Power Control Action,
like Immediate Power Off, to respond to this event.

3. Because the threshold has already been exceeded, no event is triggered to cause the Immediate
Power Off action to occur.
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4. If you reboot the system and the event condition has not been corrected (such as the
temperatureis still over threshold), the system detects the temperature condition, triggers the
event, and the corresponding action is taken. In this example action, Immediate Power Off, the
system is automatically and immediately powered off.

When the system is powered up, an infinite loop of power-up and power-down begins. To break

this cycle, you have two options:

1. Clear the event condition (cool down the system in this example).

2. Createafilenamed C:\\LRA.NOT (or insert a diskette with file \LRA.NOT in A: drive) before
the OS boots. The existence of thisfile will disable the software component that responds to
the event. The contents of the file are not important. Thisfile can be created by booting DOS.
Y ou must then delete thisfile after the problem is fixed to allow the software to operate
normally. On UnixWare systems, either create a LRA.NOT filein/ (root) directory or use the
diskette described above.

Avoiding a Reboot-Fail Retry Loop

User-defined threshold values and other user-defined configuration attributes are written to disk
(persistent storage) so they are available when the server reboots. These “remembered” values
replace the PIC default values when PIC initializes.

When you change a threshold value or dert action in PIC, you can create an environment in which
an event isimmediately generated, such as setting the Upper Noncritical Threshold value below
the current sensor reading. If the configured event actions on this threshold included a Shutdown
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or Power Control action as described earlier, the server would trigger the Shutdown or Power
Control action and could enter areboot-fail-reboot-fail cycle using the new threshold value.

To help avoid this situation, PIC updates the server in two steps:

1. Any change you makeisvalid immediately in the active instrumentation, but PIC waits five
minutes before writing user changesto disk. Thus, if the change causes the server to reboot,
the previous value is restored from disk when the server reboots.

2. PIC then uses and displays the previous value, thus avoiding the immediate reboot-fail-reboot-
fail cycle.

Any change you make will be successfully written to disk as long as the motherboard
instrumentation continues running for five minutes after the change is saved.
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Configuring Threshold Event Actions

On the Alert Actions tab page, you can select actions that will take place when a sensor exceeds a
threshold or changes state. Several options exist.

* Local actions:
O Audio/visua notifications (you may select more than one)
0 Shutdown/power control actions (you may only select one)
* Network actions:

0 AMS actions (if LANDesk Server Manager isinstalled on the server and consol€).
Generally, audio/visual notifications and AMS* alerts are for noncritical thresholds;
shutdown/power control actions are for critical thresholds.

AMS?-configurable alert actions include:

* Paging (disabled if the server hardware does not support Local Response Agent paging)

e Program execution

* SNMPtrap generation

* Message box, broadcast, and others

For more information on AM S and its alert actions, see “Configuring AMS® Alert Actions” in the
Intel LANDesk Server Manager Administrator’s Guide.
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A CAUTION
If the OS is disabled by a non-critical event (such as avoltage surge), then
critical actionswill not be carried out because the OS has been shut down. It
is best to use warnings (such as a speaker beep, a broadcast, etc.) for non-
critical conditions.
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The following tables|list the available actionsin PIC. Y ou can specify multiple audio/visual
notifications and AMS? alerts per event but only one shutdown/power control action.

Action

Emit a beep from the
managed server’s speaker

Display an alert message
on the managed server

Log the event to disk

Broadcast a message

Description
Speaker emits a beep.

Default action for noncritical and critical indications. The message box stays
up until acknowledged.

On UnixWare, Solaris, and Linux the alert message is displayed as a text
message on the server console.

Default action for all indications. This option records the event in the standard
system error log.

On NetWare, PIC records the event in the System Log, which you can view
with NetWare’s Syscon utility.

On Windows NT and Windows 2000, PIC records the event in the Windows
NT System Event Log, which you can view with the Windows NT Event
Viewer.

On UnixWare, events are logged in the system log file: /etc/.osm.

On Solaris, events are logged in the system log file: /var/adm/messages.
On Linux, events are logged in the system log file: /var/log/messages.
Default action for critical indications.

On NetWare, the message goes to all users currently logged into the
managed server with Administrator or Supervisor privileges.
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Write a message to the
managed server's LCD

Page an administrator

On Windows NT and Windows 2000, the message goes to all the users
currently logged into the managed server.

Note: Win98 cannot receive network broadcast messages from Windows NT.
If you configure a broadcast message and it is triggered on an NT server, the
message will not be received by any Win98 systems.

On UnixWare, Solaris, and Linux a text message is sent to all users currently
logged onto the UNIX server.

Default action for all indications. If the LCD is not available on the managed
server, this option is grayed out and disabled.

A page is sent to a specified pager, with the phone number of the server, an
ID number, or other numerical information.
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Action
No shutdown

Shutdown the OS

Shutdown the OS and
power off

Shutdown the OS and
hardware reset

Immediate power off

Immediate hardware
reset

Immediate NMI

Description

Default action for all indications. Select this option if you do not want to shut
down or reset the server when an event occurs.

Select this option if you want to shut down the OS gracefully (controlled, closing
files and applications).

On NetWare, the server is returned to DOS.

On Windows NT and Windows 2000, the server is set to a state ready for manual
power-off or reset.

On UnixWare, Solars, and Linux standard shutdown is completed and system
prompts for reboot or power off.

Select this option if you want to shutdown the OS gracefully and turn off the
system power.

Select this option if you want to shutdown the OS gracefully and reset the server
via hardware.

Select this option if you want to immediately power down the server. This action
is an immediate power-off without a shutdown of the OS; it might corrupt files.

Select this option if you want to immediately reset the server via hardware. This
action is an immediate hard reset without a shutdown of the OS; it might corrupt
files.

Select this option if you want to cause a hardware Non-Maskable Interrupt (NMI).
If this feature is not supported on the managed server, this option is grayed out
and disabled.
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Procedure:

1. Onthe PIC main window, click beside a sensor name in the navigation pane to see the list of
available sensors.

Select an entry from the list.

Select the Alert Actions tab.

Select the threshold type or state change condition.

Change the event actions associated with the selected threshold type or state change condition.
Click <Apply> to save your changes.

oUAwWN

82




Intel Platform Instrumentation Control Version 2.2

Configuring Third-Party Event Actions

On the Alert Actions tab page, you can select actions that will take place when athird-party
component exceeds a threshold or changes state.

Y ou can configure event actions for the following third-party components:

e Adaptec SCSI
e LSl (Symbios) SCSI
e Intel LAN Adapter
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To configure event actions for third-party indications:

1. Onthe PIC main window, click beside the third-party component name in the navigation pane.

2. Updatethe Alert Actionstab. Change the event actions associated with a threshold type or
state change condition.

3. Click <Apply> to save your changes.

The following table provides event information for third-party component instrumentation

supported by PIC.

Instrument (Notes) Choices

Adaptec SCSI* Storage Device Events Group:
Storage device state information
Storage device recovered error - Bad block repaired
Storage device member marked down
Storage Controller Events Group:
Storage Controller state information
Storage Controller SMART event
Storage Controller status unacceptable
Volume Set Events Group:

Volume set state information
Volume set recovered error
Volume set Array status - offline
Spare Events Group:

ARO spare not functional
Enclosure Events Group:
Enclosure state information
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LSI (Symbios) SCSI*

Intel LAN Adapter

Storage Devices Events Group

Device Error (not responding)

Device Warning (predicted failure(S.M.A.R.T.))
Storage Controller Events Group

Controller Error (not responding)

Mass Storage Association Events:

New Storage controller detected

New device detected

Existing controller changed

Existing device changed

Indication Control Group:
Total transmit errors threshold
Total receive errors threshold
Total host errors threshold
Total wire errors threshold

Version 2.2
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Configurable Third-Party Events (continued)
Instrument (Notes) Choices

* Event actions do not distinguish between instances of the same group. This means that event actions are configured

for a “class” of objects (i.e., host adapter) and not on individual instances of the group (i.e., host adapter 1, host
adapter 2).

Switching Views Between the Primary (Managing)
Server and an ICMB Device

To view adifferent server (ICMB device) in the navigation pane of the PIC main window, do the
following steps:
1. OnthePIC Main Menu Bar, click the ICMB->View Managed Server(s) menu selection.

2. Alistof ICMB devicesisdisplayed. Select an entry from thelist to view.
3. Click <OK>.

The tree in the navigation pane is replaced with information about the new device. At any time
you can change views to another ICMB device by repeating the steps above.

To return your view to the primary server in the navigation pane of the PIC main window, click the
ICMB->View Managing Server menu selection on the PIC Main Menu Bar.
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Configuring ICMB on the Primary (Managing) Server

To configure ICMB on the primary (managing) server, do the following steps:

1

2.
3.
4,

On the PIC Main Menu Bar, click the ICMB->View Managing Server menu selection to switch
to the primary server if you are viewing an ICMB device.

In the PIC navigation pane, click beside the ICMB component name in the navigation pane.
Update the ICMB tab page.

Click <Apply> for any changes made to the ICMB configuration.

Configuring the Watchdog Timer Value

Each motherboard supported by PIC has a watchdog timer implemented in the hardware; the timer
isdisabled by default. When enabled, the timer continually decrements to test the response of the
server operating system. Under normal operating conditions, the timer will be periodically reset
by the PIC server instrumentation software to prevent it from reaching a value of zero. If the OS
hangs, the timer will count down to zero.

If the timer reaches a value of zero, indicating an OS hang, the watchdog timer will reset the
system. The default timer value is two minutes with minimum and maximum allowable settings of
two to sixty minutes.

To configure the watchdog timer value, do the following steps:
1. OnthePIC Main Menu Bar, click the Configure->Watchdog Timer Vaue menu selection.
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2. Update the timer value.
3. Click <OK>.

ECC Memory

PIC reports memory status information, both memory arrays and memory devices, for systems that
support ECC memory. The ECC memory subsystems can detect and report both single-bit errors
(SBE) and multiple-bit errors (MBE).

Depending on the managed server hardware, memory devices are either SIMMs or DIMMSs.
Memory device references use the appropriate device name in the PIC Console software.

Single-Bit Error Handling

If an SBE occurs, the system generates an SMI that allows the BIOS to log information about the
error in the System Event Log (SEL). Thisinformation identifies the exact SIMM or DIMM in
which the error occurred. Because this condition is recoverable, the BIOS returns the system to
normal operation after logging the error.

Thiserror isindicated in the health branch of the PIC Console software as a noncritical condition,
the requested event actions are carried out, and a noncritical error count isincremented on the
Sensor Settings tab page of the software.

Also, the following actions occur in the PIC Console software:
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e TheDeviceError Typeis set to SBE on the Sensor Information tab page for the Memory
Device

e ThelLast Error Update valueis set to “During PIC Runtime,” indicating the update occurred
while the system was operational.

The BIOS stops logging noncritical SBEs when the SBE error count reaches nine. This prevents

the errors from filling the SEL. Upon system reboot, the OS uses the SEL records, along with the

results from its own memory test, to map out bad memory by reducing the usable size of a memory

bank to avoid using the bad memory element(s). This elimination of hard errorsis a precaution

that prevents SBEs from becoming MBES after the system has booted, and also to prevent SBES

from being detected and logged each time the failed location(s) are accessed. Upon reboot, the

SBE error count is set to zero in the SEL.

Multiple-Bit Error Handling

If an MBE occurs, the system generates an SM1 that allows the BIOS to log information about the
error in the SEL, identifying the memory bank in which the error occurred. However, on some
systems, it is not possible to determine the exact SIMM/DIMM that caused an MBE.

Because an MBE isacritical condition, upon logging the error the BIOS generates an NMI that
halts the system. Upon rebooting the server, this error isindicated as a critical condition on the
Memory Array and Memory Devicein the health branch of the PIC Console software. The
requested event actions are carried out, and the critical error count is incremented on the Sensor
Settings tab page of the software.
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Also, the following actions occur in the PIC Console software:

e TheDeviceError Typeis set to MBE on the Sensor Information tab page for the Memory
Device.

e ThelLast Error Update valueis set to Previous Boot, indicating the last update occurred during
the last system boot.

0




Intel Platform Instrumentation Control Version 2.2

Memory Tables

The following tables compare the steps taken with Single-bit and Multi-bit errors and provide the
type of memory information available from the PIC Console software.

SBE and MBE Comparison

Memory Error Handling SBE MBE

Generate SMI Yes Yes

Log information includes Exact SIMM or DIMM Memory bank only

Action after SEL logging Continue operation Stop the system

Indicated by PIC screen changes Immediately After the system reboots

Bad memory is mapped out at next reboot = Yes Yes (immediately after the failure)

Information available on the Sensor Information tab page of the PIC Console software:

Memory Array Dialog

Item Description

Maximum Memory Capacity The maximum memory capacity in bytes on this system

No. of Memory Device Sockets The number of memory device (SIMM/DIMM) slots or sockets
available in this memory array

No. of Memory Device Sockets Used The number of slots or sockets populated by the memory

devices in this memory array
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Memory Error Correction The hardware error correction or detection method supported

Memory Array Location

by this memory array

The physical location of the memory array, whether on the
motherboard or an add-on board

Information on the Sensor Information tab page of the PIC Console software:

Memory Device Information

Item

Size

Memory Type
Device Locator

Device Error Type
Last Error Update
Total Width
Data Width
Type Detail
Error Count

Description
Size of the memory device in bytes.
Type of memory used in the memory device.

A string identifying the socket location or board position of the memory device.
Example: “SIMM 3” or “IC12.”

Most recent type of error that occurred on the memory device.

System state during the last error update.

Total width of the memory device (SIMM/DIMM including check bits), in bits.
Data width of the memory device in bits.

More information about the memory device type.

Summary of the error status for the memory device. This read-only attribute
contains a count of all SBEs on the memory device.
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Local Response Agent (LRA) Paging

Platform Instrumentation Control lets you configure the paging features available with Baseboard
Management Controllers (BMC) and Platform Instrumentation (Pl). Actual paging activities are
performed by the BMC. If the server hardware does not support LRA, the Paging Configuration
menu itemis greyed out.

Initiating a Page

To specify that a page be sent in response to an alert, check the “Send a Page” box in the Alert
Actions dialog for the event.

Paging Configuration

Select Configure->Paging Configuration from the main menu in PIC. This configuration is global
to the server and not sensor-specific—the same page will be sent in response to all events that
have “ Send a Page” specified.
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Paging Configuration
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The Paging Configuration screen lets you configure the following information :

Global Paging Enabled : This checkbox specifies whether the paging feature is globally enabled
or disabled. If disabled, enabling paging action in the Alert Actions dialog has no effect.

Default Pager #: Thisisthe number paged when a paging action istriggered. If it is blank, no
paging occurs.

The Test Page button calls this number.

Additional Pager #1 and #2 : These are additional stored pager numbers. They are not called
when a paging event occurs or the Test Page button is pressed.

To page one of these numbers, you must copy it to the Default Pager # field, then initiate a paging
action or press the Test Page button.

Repeat Paging : The Repeat Paging feature pages the administrator multiple timesin acritical
situation. You may configure both the Repeat Paging Count and the Repeat Paging Interval. The
Repeat Paging Count specifies how many times the pager numbersin the list (one default and two
additional) should get paged. The Repeat Paging Interval specifiesthe interval in minutes between
sets of paging processes (a minimum of one and a maximum of three pages). The Repeat Paging
Count defaultsto 1. If the Repeat Paging Count is 1, the Repeat Paging Interval value is not
needed. The maximum value of Repeat Paging Count is 3. Once you set the value of Repeat
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Paging Count greater than 1, the Repeat Paging Interval field is enabled. The minimum and
default value of Repeat Paging Interval is 10 minutes. The maximum value is 60 minutes.

Enter the full pager number the way it should be dialed, including the initial number if any needs
to be dialed to get dial tone, pause characters (‘,’), areacode, etc. For example, “9,6903115.”

Before applying the number, you may press the Test Page button to verify if it is correct.
Click the OK button to save the information and exit from the screen.

Click the Cancel button to restore the previous information and exit from the screen.
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Customizing PIC Administrator Options

The Platform Instrumentation Control console has several adjustable options. Y ou can set the PIC
console refresh rate, determining how PIC is updated with current information. Y ou can specify
whether temperatures display in Celsius or Fahrenheit, and whether you want to restore PIC
settings to the factory defaults. These settings are global and affect al open PIC sessions.

PIC installs with the following defaults:

* PIC console refresh interval: 15 seconds

Temperature display format: Celsius

Watchdog feature: off

Watchdog timer: two minutes

Sensor threshold values as defined in the SDR file

To configure the refresh interval or temperature display format:

1. OnthePIC Main Menu Bar, click the View->Options menu selection.
2. Change the refresh interval or temperature display format on the Options dial og.
3. Click <OK>.

97




Intel Platform Instrumentation Control Version 2.2

[] NoTE

When configuring the console refresh interval, selecting a frequent refresh
interval impacts system performance on both the console and the managed
server because the ISC polls for the health status of each monitored sensor.
Selecting aless frequent console refresh interval provides areasonable
information update, while minimizing the overhead on system performance.
The consol e refresh interval does not impact how quickly the server system
responds to event notifications (e.g., threshold crossings) only how quickly
the 1ISC main screen display updates with server information. A value of 15
seconds or greater for console refresh value provides a reasonable
compromise.

To restore default PIC settings for threshold values, console refresh interval, and the watchdog

feature:

1. OnthePIC Main Menu Bar, click the Configure->Restore Factory Defaults menu selection.
2. Click <OK> on the confirmation dialog.

[] NoTE
Event actions you have configured and the temperature display format are
not affected by the Restore Factory Default option.

Default threshold values are stored in Sensor Data Records (SDR) in
nonvolatile storage on the motherboard. These values are determined and
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configured during motherboard manufacturing and are therefore not
documented in this manual.

A CAUTIONS
Indications may be generated if the restore of the default threshold value
crosses the current sensor value. For example:
User defined threshold limit 13.5V
Current sensor value 13.0 V
Default threshold value 12.5V
When you select the Restore Default Settings action, threshold restore may
cause athreshold crossing. In the above example, PIC would detect a
threshold crossing and generate an indication. The actions associated with
that indication would occur. To avoid the possibility of unwanted
indications when restoring default settings, Intel recommends, for each
sensor where you do not want indications, that before you select the Restore
Default Settings action, you adjust the user-defined threshold value so the
current sensor value is NOT between the user-defined threshold value and
the default threshold value.
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Platform Instrumentation Control
Event Messages

PIC allows you to configure event actions to be taken on the managed server when an event
occurs. These actions include audio/visual notifications, such as:

e Display an alert message
e Write amessage to the LCD

* Broadcast a message
The message text is based on the event information. Thistext contains the DMI MIF group and

attribute information that caused the error.

Alert Messages on the Server Console

The following table lists the alert messages that display on the server console. The general format
of these messagesis:
Event reported for <at t ri but e_nane> attribute in the <gr oup_nane> group.

100




Intel Platform Instrumentation Control

Server Console Alert Messages

Version 2.2

Alert Message

Event reported for Upper Critical Threshold
attribute in the Temperature Sensor group.

Event reported for Upper Noncritical Threshold
attribute in the Temperature Sensor group.

Event reported for Lower Noncritical Threshold
attribute in the Temperature Sensor group.

Event reported for Lower Critical Threshold
attribute in the Temperature Sensor group.

Event reported for Upper Critical Threshold
attribute in the Voltage Sensor group.

Event reported for Upper Noncritical Threshold
attribute in the Voltage Sensor group.

Description

A temperature sensor on the system reported that the
current value is above the upper critical range.

A temperature sensor on the system reported that the
current value is above the upper noncritical range but
below the upper critical range. This message is also
generated when the temperature returns to the
acceptable range.

A temperature sensor on the system reported that the
current value is below the lower noncritical range but
above the lower critical range. This message is also
generated when the temperature returns to the
acceptable range.

A temperature sensor on the system reported that the
current value is below the lower critical range.

A voltage sensor on the system reported that the
current value is above the upper critical range.

A voltage sensor on the system reported that the
current value is above the upper noncritical range but
below the upper critical range. This message is also
generated when the voltage returns to the acceptable
range.
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Server Console Alert Messages (continued)

Version 2.2

Alert Message

Event reported for Lower Noncritical Threshold
attribute in the Voltage Sensor group.

Event reported for Lower Critical Threshold
attribute in the Voltage Sensor group.

Event reported for Current Status attribute in the
Security Sensor group.

Event reported for Current Status attribute in the
Cooling Fan group.

Event reported for Array Error Type attribute in
the Memory Array group.

Event reported for Event Status attribute in the
Logical Unit group.

Event reported for Event Status attribute in the
Host Adapter group.

Event reported for Operational State attribute in
the Controller Information group.

Description

A voltage sensor on the system reported that the
current value is below the lower noncritical range but
above the lower critical range. This message is also
generated when the voltage returns to the acceptable
range.

A voltage sensor on the system reported that the
current value is below the lower critical range.

System chassis front panel or side panel has been
opened (or it was open and has been closed).
System fan has stopped (or restarted).

A memory error has been reported on the system.
A SCSI device reported a state change.

A SCSI board reported a state change.

A RAID controller reported a state change.
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Server Console Alert Messages (continued)

Version 2.2

Event reported for Operational State attribute in
the Physical Drive Information group.

Event reported for Processor Status attribute in
the Processor group.

Event reported for Power Unit Redundancy
Status attribute in the Power Unit Global Table
group.

Event reported for Total Transmit Errors
Threshold attribute in the Indication Control
group.

Event reported for Total Receive Errors
Threshold attribute in the Indication Control
group.

Event reported for Total Host Errors Threshold
attribute in the Indication Control group.

Event reported for Total Wire Errors Threshold
attribute in the Indication Control group.

Event “Status Changed to OK” reported in the
Voltage Probe group.

A RAID drive reported a state change.

A processor sensor on the system reported a processor
error.

The power supply redundancy sensor on the system
reported a power supply redundancy state change.

The LAN Adapter reported that the number of transmit
errors is above the threshold value.

The LAN Adapter reported that the number of receive
errors is above the threshold value.

The LAN Adapter reported that the number of host
errors is above the threshold value.

The LAN Adapter reported that the number of wire
errors is above the threshold value.

A Voltage probe changed its status to an OK state.
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Server Console Alert Messages (continued)

Version 2.2

Event “Status Changed to Lower Critical”
reported in the Voltage Probe group.

Event “Status Changed to Upper Critical”
reported in the Voltage Probe group.

Event “Status Changed from OK to Lower
Noncritical” reported in the Voltage Probe group.

Event “Status Changed from OK to Upper
Noncritical” reported in the Voltage Probe group.

Event “Status Changed from Lower Critical to
Lower Noncritical” reported in the Voltage Probe
group.

Event “Status Changed from Upper Critical to
Upper Noncritical” reported in the Voltage Probe
group.

Event “Status Changed to OK” reported in the
Temperature Probe group.

Event “Status Changed to Lower Critical”
reported in the Temperature Probe group.

A Voltage probe changed its status to Lower Critical
state.

A Voltage probe changed its status to Upper Critical
state.

A Voltage probe changed its status from normal to
Lower Noncritical state.

A Voltage probe changed its status from normal to
Upper Noncritical state.

A Voltage probe changed its status from Lower Critical
to Lower Noncritical state.

A Voltage probe changed its status from Upper Critical
to Upper Noncritical state.

A Temperature probe changed its status to an OK state.

A Temperature probe changed its status to Lower
Critical state.
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Server Console Alert Messages (continued)

Version 2.2

Event “Status Changed to Upper Critical”
reported in the Temperature Probe group.
Event “Status Changed from OK to Lower
Noncritical” reported in the Temperature Probe
group.

Event “Status Changed from OK to Upper
Noncritical” reported in the Temperature Probe
group.

Event “Status Changed from Lower Critical to
Lower Noncritical” reported in the Temperature
Probe group.

Event “Status Changed from Upper Critical to
Upper Noncritical” reported in the Temperature
Probe group.

Event “Internal Error” reported in the Processor
group.

Event “Thermal Trip Error” reported in the
Processor group.

Event “FRB Error” reported in the Processor
group.

A Temperature probe changed its status to Upper
Critical state.

A Temperature probe changed its status from normal to
Lower Noncritical state.

A Temperature probe changed its status from normal to
Upper Noncritical state.

A Temperature probe changed its status from Lower
Critical to Lower Noncritical state.

A Temperature probe changed its status from Upper
Critical to Upper Noncritical state.

A system processor reported an internal error.

A system processor reported a Thermal Trip error.

A system processor reported an error during the FRB
(Fault Resilient Boot) sequence.
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Server Console Alert Messages (continued)

Event “Redundancy Lost” reported in the Power = A power unit on the system lost the redundancy state.
Unit Global Table group.

Event “Redundancy Regained” reported in the A power unit on the system regained the redundancy
Power Unit Global Table group. state.

Event reported on the Storage Device Event A predictive failure noncritical on a SCSI device.
Type attribute in the Storage Device Events

group.

Event reported on the Storage Controller Event = A SCSI controller reported a state change.
Type attribute in the Storage Controller Events

group.

Event “Status Change to OKk” reported in the A PHP slot changed its status to OK.
System Slot group.

Event “Status Changed to Non-Critical” reported = A PHP slot changed its status to Non-Critical.
in the System Slot group.

Event “Status Changed to Critical” reported in A PHP slot changed its status to Critical.

the System Slot group.

Event “Slot Power On” reported in the System A PHP slot changed its power state from Off to On.
Slot group.

Event “Slot Power Off” reported in the System A PHP slot changed its power state from On to Off.
Slot group.
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Broadcast and LCD messages
The following table lists broadcast and LCD messages.

Broadcast messages are sent across the network to client computers. The general format of
broadcast messagesis:

Check <group_name> at server <server_name>

L CD messages are displayed on the managed server’sLCD. These are limited to 32 characters;
longer messages are truncated. The general format of LCD messagesis:

Check: <group_name>

Table 19. Broadcast and LCD Messages

Message Description

Check: Temperature Sensor. A temperature sensor reported a change in state

Check: Temperature Probe. (OK/Noncritical/Critical).

Check: Voltage Sensor. A voltage sensor reported a change in state

Check: Voltage Probe. (OK/Noncritical/Critical).

Check: Security Sensor. System chassis front panel or side panel has been opened (or

Check: Physical Container Global Table. | it was open and has been closed).
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Check:
Check:
Check:
Check:
Check:
Check:
Check:
Check:

Check:
Check:

Check:
Check:

Check

Cooling Fan.

Memory Array.

Host Adapter.

Logical Unit.

Controller Information.
Physical Drive Information.
Processor.

Power Unit Global Table.

Power Supply.
Indication Control Group.

Storage Device Events.
Storage Controller Events.

: System Slot.

Version 2.2

System fan has stopped (or restarted).

A memory error has been reported on the system.
A SCSI board reported a state change.

A SCSI device reported a state change.

A RAID controller reported a state change.

A RAID drive reported a state change.

A processor error has been reported on the system.

A power unit redundancy state change has been reported on
the system.

A power supply failed on the system.
The LAN Adapter reported a threshold crossing.

A SCSI device reported a state change.
A SCSiI controller reported a state change.

A PHP slot reported a state change.
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Appendix A DMI to SNMP Translator

Y ou can use the DMI-SNMP Trand ator to integrate DMI management with SNMP. The trandator
attaches directly to the Network OS's SNMP agent and to the DMI Service Layer by registering as
amanagement application. The trandator translates management requests from SNMP to DMI

and responses from DMI to SNMP. DMI events (indications generated by the component
instrumentation when athreshold is crossed or a sensor changes state) are trandated into
enterprise-specific SNMP traps.

The trand ator trandl ates these MIFs;

» Baseboard

« ICMB

e Loca Response Agent
e Adaptec SCSI

e LSl (Symbios) SCSI

e Intel LAN Adapter

The trangdlator raises atrap when aDMI indication isreceived. The DMI-SNMP Trandlator does
not support configured actions. This alerting mechanism works independently of the Local
Response Agent.

110




Intel Platform Instrumentation Control Version 2.2

For the DMI-SNMP Tranglator to work correctly, the SNMP Agent on the managed server OS
must be configured correctly. For example, the Windows NT, Windows 2000, NetWare, Solaris,
Linux, or UnixWare SNMP Agents need some configuration to enable the server to send SNMP
traps to specific SNMP management consoles. To configure the SNMP Agent on the server, see
the documentation supplied by the OS vendor.

To manage the DMI information supplied by PIC software through the SNM P management
workstation, the following MIBs must be compiled on the SNMP console:

« ADAPTEC.MIB
« BASEBRD.MIB
» BASEBRD2.MIB
» BASEBRD3.MIB
« ClO.MIB

+ EI100B.MIB

« |ICMBFEAT.MIB
* INTELNIC.MIB
* LRA.MIB

* MAPBASE2.MIB
 MAPLRA.MIB

« MAPSHA.MIB

* RMTCHASMIB
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« SHA.MIB
+ SYMBIOS2.MIB
+ SYMSDMS2.MIB

These MIB files are installed during the PIC Console and PIC Server installation. Thefilesare
copied to the %PIC_PATH%\SNMPMIBS directory during installation. PIC_PATH isthe
installation directory chosen during install.

The procedures for compiling these M1Bs depend on the SNMP console being used. For more
information, see the documentation supplied with your SNMP console software.
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